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Introduction 

This Job Aid is intended for all CONNECTIONS users. It provides a detailed overview of the 
CONNECTIONS system changes being introduced with Build 18.9.7 (Q2-08).  

Improvements to CONNECTIONS that are implemented periodically through SIRs and Change 
Requests are referred to as "Builds." Since these improvements are implemented on a quarterly 
basis, they are also being called Quarterly Improvement Plans and are referred to this year as 
Q1-08; Q2-08; Q3-08 and Q4-08. The Q1, 2, 3, or 4 means the quarter of the year beginning in 
January and "08" means 2008. Build 18.9.7 to be released in June is called "Q2-08." In the 
future, after Build 18.9.10, the "Build" designation will be dropped and the improvements will be 
referred to as "Q1, 2, 3, or 4-the year." 

With the implementation of Build 18.9.7 (Q2-08), several important changes will improve the 
CONNECTIONS system. It should be noted that many of the enhancements included in this 
Build originated from a collaborative effort on the part of OCFS, local district and voluntary 
agency casework and supervisory staff, who were members of the Functional Improvement 
Team (FIT). Specifically, this Job Aid contains information about enhancements in the following 
functional areas: 

• Reports 

• Family Assessment and Service Plans (FASPs), including the Service Plan Review 

• Permanency Hearing Reports 

• Progress Notes 

• Security 

 

 

Any visible identifying data 
in this Job Aid is simulated. 

 

 

This Job Aid assumes familiarity with the 
CONNECTIONS System. 

 
This Job Aid is available online on the CONNECTIONS intranet site: 

OCFS.state.nyenet/connect/jobaides.asp 

The CONNECTIONS intranet site also contains information about CONNECTIONS training. 
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Child Protective Case Summary: Prior Case Summary Report 

With the implementation of Build 18.9.7 (Q2-08), CPS workers will be able to generate a CPS 
Prior Case Summary Report, which provides a summary of the entire case history of family 
members in a new CPS intake or investigation. 

The Prior Case Summary Report is an on-demand report that 
can be run at any time. Since it runs in the background of the 
desktop, it doesn’t affect any other work being done in 
CONNECTIONS. The report is available from the Assigned 
Workload by highlighting an Intake or Investigation stage and 
selecting the Prior Case Summary Report command on the 
Reports menu. It can only be generated by local district CPS 
workers. Voluntary agency workers are not permitted access to 
this report due to the confidentiality of Unfounded reports.  

The report summarizes all prior CPS and FSS stages for individuals in the current investigation. 
This case-level report is divided into four sections: 

• Household Composition—Contains current 
demographics for individuals in the target stage (Intake or 
Investigation) from which the report was launched. 

• Role Information—Contains a list of prior stage 
involvement for each individual in the target stage, 
including, stage type, classification, determination, and 
start and end dates, as well as individual role and relationships. 

 
 

NYC Workers: 
Check with your supervisor for 
information on your agency’s 

policy and procedures for 
generating the report.  

 
No Reporter/Source information 

is included in the report. 

 
Due to the comprehensive and 

sensitive nature of the 
information contained in the 
report, you need to take all 
precautions to ensure that it 

does not fall into the hands of 
anyone not fully authorized to 

have the information it contains. 

• Detailed Stage Information—Contains specific 
information for each cross-referenced stage listed in the 
Role Information section. Information varies by stage type, 
but includes: 

o information on In-process, Indicated and 
Unfounded investigations, such as allegations, 
safety and risk information; 

o Family Services Intake information such as 
requested emergency services, Behavioral 
Concerns and Family Issues data, etc.; 

o Family Services Stage information such as 
Permanency Planning Goal (PPG), Program 
Choice, Risk Rating and Safety Assessment 
data, etc.; and 

o worker and agency information for all stages. 

• Additional Individuals—Lists persons who are not in the target stage, but who were in 
one or more of the cross-referenced stages. For example, this might include duplicate 
persons, adults who are no longer in the current household, or other children or adults 
actually in the household who were not mentioned in the target stage. 

See Appendix A for a sample of the Prior Case Summary Report. 

Due to the potential size of the report, each agency may have procedures in place for printing 
the document. You should check with your supervisor for printing policies. 
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Although this Report contains a more comprehensive view of a family’s hjstory than other 
reports currently available, it is still only one source of information and is no substitute for the 
gathering of all available information, such as a thorough review of all records and consultations 
with other involved workers to the fullest extent possible. 

Reports are only as good as the information they are drawing upon in CONNECTIONS. That is 
why it is very important to merge persons with multiple Person IDs; otherwise, a complete case 
history will not display. Each individual in the database should have only one Person ID. The 
new monthly Multiple Person Report can be used to assist in completing the person merge 
process. It is also a good idea to make any other necessary updates to case information before 
printing this report, which will greatly add to its accuracy. 

Whenever adding a person to a stage, you need to understand the importance of doing a good 
search and relating, when appropriate, to existing Person IDs in CONNECTIONS. 

The programmatic requirements relating to a comprehensive review of records of prior reports 
are not satisfied by a review of the new Prior Case Summary Report. Workers that receive a 
new investigation continue to be responsible for the following: 

• Within one business day of the oral report, review SCR records pertaining to all prior 
reports involving the members of the family, including legally sealed reports, where the 
current report involves a subject of the Unfounded report, a child named in the 
Unfounded report, or a child’s sibling named in the Unfounded report. 

• Within five business days of the oral report review local district’s own CPS records that 
apply to the new report, including legally sealed Unfounded reports.   

• Within one business day of the oral report request relevant portions of records regarding 
cases investigated by other districts, if applicable. 

 

Step-by-Step: 
Generating the Prior Case Summary Report  

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

 
When the report can not be 

launched, the following 
message displays:  

“The report could not be 
launched. Contact Help Desk.” 

2 Select the desired INV or INT stage. 

3 Click on the Reports menu and select the Prior 
Case Summary Report command. 
The following message displays: 
“The Report has been launched. Check Report List 
Window.” 

4 Click on the OK button. 

5 Click on the RPRTS button on the Toolbar. 
The Report List displays. 

6 Select the Prior Case Summary Report. 
Make sure the report’s status reads “DONE.” If it does not, either refresh the window 
by clicking on the Refresh button, or close the Report List and try again in a few 
minutes. You need to wait for the report to launch completely before you can view it. 

7 Click on the Open button. 
The report displays as a Microsoft Word document. 
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Closed Person Stage Involvement Report 

Prior to Build 18.9.7 (Q2-08), when a Person Merge was 
completed, CONNECTIONS did not retain the stage-specific 
history for the closed person. If the merge was completed in 
error, the lack of the closed person’s history made the split 
process difficult to accurately complete. 

 
The decision to complete a 

Person Merge/Split should be 
thought out thoroughly and 

discussed with your supervisor, 
if necessary, prior to completing 

the merge or split. 

In order to split or undo two 
Person IDs merged in error, a 

worker must reactivate the 
closed Person ID and manually 
restore the closed person to the 

appropriate stages, with the 
correct role. 

With the implementation of Build 18.9.7 (Q2-08), stage-specific 
information for the closed person will be stored by the system, 
and a report can be generated listing the stages and the role of 
the closed person prior to the merge. If a split becomes 
necessary, this report is to be used as the starting point in 
rebuilding the closed person’s history. 

See Appendix B for a sample of the Closed Person Stage 
Involvement Report. 

 

 

Step-by-Step: 
Generating the Closed Person Stage Involvement Report  

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select the desired stage from the Assigned Workload. 

3 Click on the Options menu and select the Person List command. 
The Person List displays. 

4 Select the desired person from the grid. 

5 Click on the Options menu and select the Person Merge/Split command. 
The Person Merge/Split window displays. 

6 Select the person from the grid. 

7 Click on the Reports menu and select the Closed Person Stage Involvement 
command. 

8 The following message displays: 
“The Report has been launched. Check Report List Window.” 
You can click on the RPRTS button at any time. You don’t need to close any other 
windows to do so. 

9 Click on the OK button. 

10 Click on the RPRTS button on the CONNECTIONS Toolbar. 
The Report List displays. 
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11 Click on the Closed Person Involvement Report. 
Make sure the report’s status reads “DONE.” If it does not, either refresh the window 
by clicking on the Refresh button, or close the Report List and try again in a few 
minutes. You need to wait for the report to launch completely before you can view it. 

12 Click on the Open button. 
The report displays as a Microsoft Word document. 

13 To print the report, click on the File menu and select the Print command. 
The Microsoft Word Print dialog box displays. 

14 Verify that the default printer choice is correct. If you want to print multiple copies, 
enter the number in the Copies field. 

15 Click on the OK button. 
The document is sent to the selected printer. 

16 To close the report, click on the File menu and select the Close the command. 
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Family Assessment and Service Plans (FASPs) 

Enhancements to the FASP Tree 
With Build 18.9.7 (Q2-08), the FASP tree will be modified to include additional indicators to help 
you identify sections of the FASP that are required in order to complete the FASP, or that can 
be optionally completed, or that are not applicable: 

► Required 
An indicator of “Required” will appear on the tree 
next to FASP components that must be completed 
based on the program choice and PPG in effect 
when the FASP is launched. 

► Optional 
o An indicator of “Optional” will appear on the tree 

next to components that are added by a worker 
through “Add a FASP Component.” 

 The system does not require a 
component that was added by a worker 
to be completed in order to submit the 
FASP for approval. 

 An optional component added by a 
worker will remain on the tree 
regardless of whether information is 
entered for that component. 

o An indicator of “Optional” will appear on the tree next to components that were required 
at one time based on Program Choice/PPG, but are no longer required due to a change 
in that Program Choice/PPG after FASP launch. The “Optional” indicator will appear 
whenever data had been previously saved for the component. 

 The system does not require these components be completed in order for the 
FASP to be submitted for approval. 

 If no information is recorded for these optional components, they will no longer 
be visible on FASP tree after the Program Choice/PPG change.  

 If any information is recorded in the component it will remain on the FASP tree as 
“Optional.” 

► Not Applicable 
An indicator of “Not Applicable” will appear on the FASP tree for RAP and Parent/Caretaker 
Scales when these components are not enterable because a Parent/Caretaker has not 
been identified on the Stage Composition tab. 
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► There will be no indicators displayed on the tree for: 

 
You can delete a Discharge 

Protocol that was launched in 
error or where the incorrect 

version was selected. When a 
Discharge Protocol is deleted, it 

is deleted for all children in a 
stage, not just the selected 

child. 

To delete the information from 
the Discharges window, click on 
the Options menu and select 

Delete Protocol. 

The following message 
displays: 

“This Discharge information will 
be deleted for all children. Do 

you wish to continue?” 

Clicking on the Yes button 
deletes the selected discharge 
protocol information; the label 

for the deleted protocol is New. 

If you selected the incorrect 
discharge type, you can select 

the appropriate one and 
complete the protocol. Clicking 

on the No button brings you 
back to the Discharges window 

to allow you to do so. 

o components that are on the tree, but optional until 
data is entered. These are:  

 Non-LDSS Visiting Plan 
 Non-LDSS Life Skills Assessment 
 Discharges 

o Plan Amendment 
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Enhancements to the Check FASP Detail Component Status Window 
Each FASP, Removal Update or Plan Amendment contains multiple components that are 
required to be completed before a FASP is submitted for approval. At any time during the 
completion of a FASP, you can click on the Check FASP Detail (or Check Removal Detail) 
button to receive a list of incomplete components, if any. Prior to Build 18.9.7 (Q2-08), in order 
to complete a component you had to close the Check FASP Detail Component Status window 
and navigate from the FASP tree to that component.  

With the implementation of Build 18.9.7 (Q2-08), the Check FASP Detail process is made 
simpler. When a FASP component is incomplete, you can navigate directly from the Check 
FASP Detail Component Status window by clicking on an incomplete component. This action 
opens the first tab of the selected component, allowing you to complete any necessary work on 
that tab or, if necessary, to navigate to other tabs within that component. Upon closing the 
selected component, the Check FASP Detail Component Status window displays.  

If you select an incomplete component for an In Process or Pending FASP/Plan Amendment 
with a due date of one year or more before today’s date, the following message displays with 
Yes and No buttons: 

“Please confirm your decision to mark the in–process or pending FASP to Template Format.” 

Clicking on the Yes button will drop the FASP to template format and return you to the Family 
Assessment and Service Plan window. Clicking on the No button will maintain the status as is; 
the Check FASP Detail Component Status window will remain open.  
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A new button has been added to the Check FASP Detail Component Status window: Refresh 
List, which updates the component list. This button is enabled whenever there is an incomplete 
component. You may wish to click on this button, for example, after navigating from the window 
and completing additional work on an incomplete component. If the work you performed 
completed the component, clicking on the Refresh List button will remove the completed 
component from the list. 

 

Step-by-Step: 
Navigating to an Incomplete Component 

1 Click on the Check FASP Detail button. 
The Check FASP Detail Component Status window 
displays. If there are any incomplete FASP 
components, they display on the window. If all FASP 
components are complete, the window is clear.  

Where am I? 

Assigned Workload > FSS > 
Tasks > FASP tab 

2 Click on an incomplete component to navigate to the 
corresponding section of the FASP. 
The selected component displays. 

 

Approval To-Do Enhancement for Multiple Approvers 
Currently, when a FASP, Removal Update, or FSS stage closure is submitted for multiple 
approvals, there is a hierarchy established by the system, which allows the approvers to 
complete their approvals in a defined sequence; this typically occurs when there is voluntary 
agency involvement. However, the Approval To-Do that each approver received did not provide 
them with any indication that the FASP, Removal Update, or stage closure was ready for them 
to approve.  

With the implementation of Build 18.9.7 (Q2-08), the text of these Approval To-Dos contains an 
indicator that specifies whether or not the FASP, Removal Update, or stage closure is ready for 
that particular approver to approve, which serves to minimize potential confusion. 

The following message displays upon selecting the Approval To-Do and clicking on the 
Navigate… button when the FASP, Removal Update, or stage closure is not yet approvable 
because of the order in which the approvals must occur: 

 

 

Clicking on the Yes button displays the FASP report, Removal Update report, or Case Summary 
window, depending on the To-Do. Clicking on the No button returns you to the Staff To-Do List. 
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Permanency To-Dos 

With the implementation of Build 18.9.7 (Q2-08), Permanency Hearing Report To-Dos display 
as Alert To-Dos. This will eliminate the error you received when attempting to navigate from a 
Permanency Hearing Report Task To-Do.  

Alert To-Dos will be generated when a Permanency Hearing Report is coming due or overdue. 
In addition, if the Permanency Hearing Date Certain is greater than 75 days from today’s date, 
an Alert To-Do will be generated, which informs you that an SPR/Consultation is due no earlier 
than 60 days prior to the Permanency Hearing Date Certain. 

Although you will have to manually navigate to the Permanency Hearing Report tab to launch 
and complete the report, you will be able to delete the Alert To-Dos when you no longer need 
them.  
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Accessing Progress Notes 

In order for you to access progress notes more easily, a Progress Notes… button has been 
added to the Assigned Workload. This button is enabled when only one stage is selected on the 
workload. Clicking on the Progress Notes… button opens the Progress Notes window for that 
stage. Closing the Progress Notes window when accessed this way returns you to the Assigned 
Workload. 

 

 

 

 

Step-by-Step: 
Accessing Progressing Notes via the Assigned Workload 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select the appropriate stage. 
The Progress Notes… button enables. 

3 Click on the Progress Notes…button. 
The Progress Notes window displays. 
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Adoption Finalization/Stage Closure 

Prior to the implementation of Build 18.9.7 (Q2-08), you could close a CCR stage with an 
Adoption Finalized closure reason without recording the necessary information on the Finalize 
Adoption window. If the adoption finalization was not saved before the CCR stage was closed, 
the record was not sealed. All finalized adoption records must be sealed in the system. 

With the implementation of Build 18.9.7 (Q2-08), in order to properly seal the record you must 
complete and save all required information on the Finalize Adoption and AFCARS Adoption 
Information windows before you can save the closure reason and proceed with closing the 
stage.  

All case closure reasons will display in the Reason Stage Closed drop-down menu on the 
Case Summary window, including the Adoption Finalized closure reasons (“Adoption Finalized 
with Subsidy” and “Adoption Finalized - without Subsidy”). If you select one of these closure 
reasons and the Finalize Adoption window has not been completed, the following message 
displays upon clicking on the Submit button: 

“Finalize Adoption and AFCARS Adoption Information must be completed.” 

You must complete the Finalize Adoption and AFCARS Adoption Information windows in order 
to proceed with closing the CCR stage.  

 

 

Also supported in Build 18.9.7 (Q2-08) is the capacity for a New York State employee assigned 
the MAINT ADOPT FINL Business Function to update closed CCR cases where it is needed.
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Security: Maintain Education Business Function 

With the implementation of Build 18.9.7 (Q2-08), the MAINT 
EDUCATION Business Function is available and associated 
access is supported in CONNECTIONS. Although the Enter 
Education Security Attribute was made available in a previous 
Build, it becomes operational with the MAINT EDUCATION 
Business Function created in Build 18.9.7 (Q2-08). 

This Business Function, in conjunction with the CASE/PERS 
SEARCH or CASE SEARCH Business Function provides 
workers without a role in the stage with the ability to view and record education information. This 
Business Function provides access only to the Education functionality, allowing workers who 
specialize in educational services to complete their work.  

 
Refer to Appendix C for the 

MAINT EDUCATION Business 
Function Guidelines. 

 
If a worker who needs access 

only to education information in 
CONNECTIONS is assigned a 
role in the stage, that worker 
should be unassigned and 
instead given the MAINT 

EDUCATION and the 
CASE/PERS SEARCH (or 
CASE SEARCH) Business 

Functions. 

It is recommended that a staff person who has responsibility for 
the entry of education information, but no other responsibility for 
a stage should be given this Business Function. For example, a 
typical use of this Business Function is for educational staff in 
voluntary agency on-campus schools. This will limit access to a 
child’s full CONNECTIONS record and instead provide access 
only to the portion of the record that is relevant to them, which 
is the Education functionality. 

If an agency or district is using Agency Access, those settings 
must be considered when assigning the MAINT EDUCATION 
Business Function. The Security Coordinator needs to take 
certain actions for person(s) with only the MAINT EDUCATION 
and CASE/PERS SEARCH (or CASE SEARCH) Business 
Functions in order to prevent inappropriate access to 
information: 

 Do not make the user Case Assignable. 

 Do not make the user a Unit Approver. 

 Do not put the user in a supervisory unit in the Organizational Hierarchy. 

 Do not give the user a Job Type. 

The Agency Access window is used to create and maintain FSI and FSS stage access 
privileges for persons within your agency. Agency staff can be granted view privileges, maintain 
privileges or no privileges for each staff grouping (i.e., Case Assignable Staff, Unit Approvers, 
and those in the Direct Supervisory Line). Access must be granted on a “Need to Know” basis; 
no staff should be granted access until or unless they need that access.  
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Step-by-Step: 
Accessing the Education Window  
(with the MAINT EDUCATION Business Function) 

1 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Enter the Case ID number in the Case ID field (or the Stage ID number in the Stage 
ID field). 
The Search button enables. 

3 Click on the Search button. 
The Case List displays with the only case that matches the search criteria. 

4 Select the case from the Case List. 
The Summary button enables. 

5 Click on the Summary button. 
The Case Summary window displays. 

6 Select the Family Services Stage. 

7 Click on the Options menu and select the Stage Maint command. 
A sub-menu displays. 

8 Select the Maintain Education command. 
The Education window displays. 
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Support Tools 

Online Help 
CONNECTIONS Online Help provides descriptions for various windows, as well as step-by-step 
instructions for common tasks. You can access Online Help at any time, from any window in 
CONNECTIONS by clicking on the Help menu or pressing the F1 key on your keyboard. 

The Contents, Index and Search tabs in Online Help allow you to search for and navigate to 
the topic(s) on which you need help. 

 

Step-by-Step: 
Accessing Online Help 

1 Click on the Help menu on the CONNECTIONS Toolbar. 
The following list of commands displays: 

Contents A table of contents for the help facility with links to major sections. 
How Do I? Step-by-step instructions to help you complete tasks using 

CONNECTIONS. 
Window 
Descriptions 

Descriptions of windows in CONNECTIONS, along with information on 
various fields. 

DSS Policy Online OCFS policy handbooks (under revision). 
Help On This 
Window 

Window description help for the window you are on. 

Help for Help Instructions on how to use the help functionality. 
About 
CONNECTIONS 

Information about the current CONNECTIONS version and build. 

2 Click on a command from the Help menu. 
The window related to your selection displays. In some cases, you will need to make 
another selection in that window to obtain instructions. At the top of each window you 
will see additional buttons and menus. Use the Search button to search for specific 
information in the Help function and use the Back button to return to windows you 
have just visited in Help. The Glossary button opens a list of important 
CONNECTIONS terms and the Print button allows you to print Help information. 

3 When you are done reviewing information in Help, close each Help window by 
clicking on the Close button ( ) in the top right corner of the window. 
The system returns to the window you were using when you accessed Help. 
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OCFS CONNECTIONS Intranet Site 
A variety of training-related materials are available from the OCFS CONNECTIONS intranet site 
(http://ocfs.state.nyenet/connect/). The intranet site contains a wealth of information related to 
various aspects of CONNECTIONS, including training schedules, Alerts and Notices, Step-by-
Step Guides (including the CONNECTIONS Case Management Step-By-Step Guide), Job Aids 
and Frequently Asked Questions (FAQs). Release Notes—a complete list of the modifications, 
enhancements, fixes and impacts in the Build—is also available from the CONNECTIONS 
intranet site. 

 

Step-by-Step: 
Accessing the OCFS CONNECTIONS Intranet Site 

1 From your local desktop, double-click on the Internet Explorer icon. 

2 If the browser does not display the OCFS intranet site automatically, enter 
http://ocfs.state.nyenet into the browser’s address line and press the Enter key on 
your keyboard. 
The OCFS intranet home page displays. 

3 Click on the CONNECTIONS link. 
The CONNECTIONS home page displays. 

4 Click on a topic to access information. For access to various Step-by-Step Guides 
and Job Aids, click on the Step-by-Step/Job Aids/Tips link. For access to Release 
Notes for a Build, click on the Implementation link. 

5 To close Internet Explorer, click on the File menu and select Close. 

Enterprise Help Desk 
The New York State Office for Technology (NYS OFT) Enterprise Help Desk staff is available to 
answer basic questions related to your equipment or to solve problems you are having with the 
CONNECTIONS application. If they cannot solve your problem, they will record your information 
and forward it to others who can. 

Your agency may have procedures in place for contacting the Enterprise Help Desk. Check with 
your supervisor before you call. 

The Enterprise Help Desk is staffed 24 hours a day, seven days a week. The telephone number 
is: 

1-800-NYS-1323 
(1-800-697-1323) 

When you call the Enterprise Help Desk with a problem, you will be given a ticket number to use 
for tracking your issue and its resolution. Keep a record of this number; you will need it for any 
follow-up conversations with the Enterprise Help Desk. 
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App Help Mailbox 
In addition to calling the Enterprise Help Desk with application 
issues, district staff can directly contact the NYS 
CONNECTIONS User Support/Triage staff for help with 
complex application issues. Questions, problems and concerns 
can now be emailed to:  

ocfs.sm.conn_app@ocfs.state.ny.us 
The ‘App Help’ mailbox is intended to provide an expanded 
level of support. It is meant for questions that have had an initial 
review by agency staff who are proficient in CONNECTIONS 
(e.g., Resource Users). For example, if you have an issue for 
which you have unsuccessfully sought advice from your supervisor or a Resource User, it would 
be appropriate to contact the App Help mailbox with the issue. However, your in-agency 
resources should always be your first contact when trying to resolve an issue. 

 
For more information on the 

App Help mailbox, refer to the 
Implementation page of the 

OCFS CONNECTIONS 
intranet site: 

http://ocfs.state.nyenet/connect/
imp/ 
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Appendix A: 
Prior Case Summary Report 
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Appendix B: 
Closed Person Stage Involvement Report 
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Appendix C: 
Maintain Education Business Function Guidelines
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Business 
Function (BF) 

Security 
Attributes Description Recommendations Comments Agency Access 

Considerations 
MAINT 
EDUCATION 

Enter Education • MAINT Education BF works in 
conjunction with the Case 
Search (if Voluntary Agency) 
or the Case/ Pers Srch BF (if 
LDSS),i.e. the user must have 
both to access Education 
(without a role).  

• Path: Case Search > Case 
Summary->Options menu -> 
Stage Maint menu -> Maintain 
Education menu item (opens 
in Modify mode unless stage is 
pending closure). 

• The Maintain Education menu 
item on the Case Summary 
window will be enabled when: 
1. Worker has the Business 
Function "MAINT 
EDUCATION"  
2. Worker has selected an 
open FSS stage with stage 
type of CWS or CCR or 
ADVPO.  
3. Worker is from the same 
district/local agency as one of 
the workers assigned to the 
stage (CM, CP, CW).  

• For stages pending closure, 
the worker with the MAINT 
EDUCATION BF will enter in 
browse mode only. 

• There is no access to closed 
stages with the MAINT 
EDUCATION BF. 

It is recommended that 
a staff person who has 
responsibility for the 
entry of education 
information, but no other 
responsibility for the 
stage, should be given 
this Business Function.   

• The district of the case 
includes the district or 
agency of a worker 
with a role (CM, CP, 
CW). 

• Office Types: District / 
Voluntary Agency/ RO/ 
DJJOY (DFY) / CQC / 
OMH/ OMRDD 

• MAINT EDUCATION 
BF is not needed if the 
worker has a role in the 
stage. 

• There is no 
maintenance permitted 
of Education 
information once a 
stage is pending 
closure or closed. 

 

When the district or agency 
uses the Agency Access 
Window settings, in order to 
prevent someone with the 
MAINT EDUCATION BF 
who is only intended to 
access Education Dialog 
from this path, from 
accessing events on the 
Case List window, the 
district or agency will need 
to take action make sure 
that all of these apply to the 
user. The user is: 1. not 
Case Assignable, 2. not a 
Unit Approver, 3. not in a 
Supervisory Unit in the 
Organizational Hierarchy 
and 4. does not have a Job 
Type. 

If this is done, and your 
Agency Access settings 
change, the user will still not 
be able to access events. 

Refer to the Guide to Using 
the Maintain Agency and 
Organizational Hierarchy 
Functions in 
CONNECTIONS and the 
CONNECTIONS Step-by-
Step Guide: Security for 
more information. 
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